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ADOBE DREAMWEAVER CC CLASSROOM IN A BOOK 2017 RELEASE 1

Adobe® Dreamweaver CC is the industry-leading web-authoring program. 
Whether you create websites for others for a living or plan to create one 
for your own business, Dreamweaver offers all the tools you need to get 
professional-quality results.

About Classroom in a Book
Adobe Dreamweaver CC Classroom in a Book® (2017 release) is part of the 
official training series for graphics and publishing software developed with the 
support of Adobe product experts.

�e lessons are designed so you can learn at your own pace. If you’re new to 
Dreamweaver, you’ll learn the fundamentals of putting the program to work. 
If you are an experienced user, you’ll find that Classroom in a Book teaches 
many advanced features, including tips and techniques for using the latest  
version of Dreamweaver.

Although each lesson includes step-by-step instructions for creating a specific 
project, you’ll have room for exploration and experimentation. You can follow 
the book from start to finish or complete only those lessons that correspond to 
your interests and needs. Each lesson concludes with a review section contain-
ing questions and answers on the subjects you’ve covered.

TinyURLs
At several points in the book, I reference external information available on the 
Internet. �e uniform resource locators (URLs) for this information are often 
long and unwieldy, so I have provided custom TinyURLs in many places for 
your convenience. Unfortunately, the TinyURLs sometimes expire over time 
and no longer function. If you find that a TinyURL doesn’t work, look up the 
actual URL provided in the appendix.

GETTING STARTED



2 GETTING STARTED

Prerequisites
Before using Adobe Dreamweaver CC Classroom in a Book (2017 release), you 
should have a working knowledge of your computer and its operating system. 
Be sure you know how to use the mouse, standard menus, and commands, as 
well as how to open, save, and close files. If you need to review these techniques, 
see the printed or online documentation included with your Windows or Mac 
operating system.

Conventions used in this book
Working in Dreamweaver means you’ll be working with code. We have used several 
conventions in the following lessons and exercises to make working with the code 
in this book easier to follow and understand.

Code font
In many instructions, you will be required to enter HTML code, CSS rules, and 
properties and other code-based markup. To distinguish the markup from the 
instructional text, the entries will be styled with a code font, like this:

Examine the following code: <h1>Heading goes here</h1>

In instances where you must enter the markup yourself, the entry will be formatted 
in color, like this:

Insert the following code: <h1>Heading goes here</h1>

Strikethrough
In several exercises, you will be instructed to delete markup that already exists 
within the webpage or style sheet. In those instances, the targeted references will be 
identified with strikethrough formatting, like this:

Delete the following values:

margin: 10px 20px 10px 20px;
background-image: url(images/fern.png), url(images/stripe.png);

Be careful to delete only the identified markup so that you achieve the following 
result:

margin: 10px 10px;
background-image: url(images/fern.png);
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Missing punctuation
HTML code, CSS markup, and JavaScript often require the use of various punctua-
tion, such as periods (.), commas (,), and semicolons (;), among others, and can be 
damaged by their incorrect usage or placement. Consequently, I have omitted peri-
ods and other punctuation expected in a sentence or paragraph from an instruction 
or hyperlink whenever it may cause confusion or a possible error, as in the follow-
ing two instructions:

Enter the following code: <h1>Heading goes here</h1>

Type the following link: http://adobe.com

Element references
Within the body of descriptions and exercise instructions, elements may be ref-
erenced by name or by class or id attributes. When an element is identified by its 
tag name, it will appear as <h1> or h1. When referenced by its class attribute, the 
name will appear with a leading period (.) in a code-like font, like this: .content 
or .sidebar1. References to elements by their id attribute will appear with a lead-
ing hash (#) and in a code font, like this: #top. �is practice matches the way these 
elements appear in Dreamweaver’s tag selector interface.

Windows vs. macOS instructions
In most cases, Dreamweaver performs identically in both Windows and macOS. 
Minor differences exist between the two versions, mostly because of platform- 
specific issues out of the control of the program. Most of these are simply dif-
ferences in keyboard shortcuts, how dialogs are displayed, and how buttons are 
named. In most cases, screen shots were made in the macOS version of Dream-
weaver and may appear different from your own screen.

Where specific commands differ, they are noted within the text. Windows com-
mands are listed first, followed by the macOS equivalent, such as Ctrl+C/Cmd+C. 
Common abbreviations are used for all commands whenever possible, as follows:

Windows macOS
Control = Ctrl Command = Cmd
Alternate = Alt Option = Opt 

As lessons proceed, instructions may be truncated or shortened to save space, 
with the assumption that you picked up the essential concepts earlier in the lesson. 
For example, at the beginning of a lesson you may be instructed to “press Ctrl+C/
Cmd+C.” Later, you may be told to “copy” text or a code element. �ese should be 
considered identical instructions.

http://adobe.com
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If you find you have difficulties in any particular task, review earlier steps or 
exercises in that lesson. In some cases if an exercise is based on concepts covered 
earlier, you will be referred to the specific lesson.

Installing the program
Before you perform any exercises in this book, verify that your computer system 
meets the hardware requirements for Dreamweaver, that it’s correctly configured, 
and that all required software is installed.

If you do not have Dreamweaver, you will first have to install it from Creative 
Cloud. Adobe Dreamweaver must be purchased separately; it is not included with 
the lesson files that accompany this book. Go to www.adobe.com/products/
dreamweaver/tech-specs.html to obtain the system requirements.

Go to https://creative.adobe.com/plans to sign up for Adobe Creative Cloud. 
Dreamweaver may be purchased with the entire Creative Cloud family or as a 
stand-alone app. Adobe also allows you to try Creative Cloud and the individual 
applications for 7 days for free.

Check out www.adobe.com/products/dreamweaver.html to learn more about the 
different options for obtaining Dreamweaver.

http://www.adobe.com/products/dreamweaver/tech-specs.html
http://www.adobe.com/products/dreamweaver/tech-specs.html
https://creative.adobe.com/plans
http://www.adobe.com/products/dreamweaver.html
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Updating Dreamweaver to the latest version
Although Dreamweaver is downloaded and installed on your computer hard drive, 
periodic updates are provided via Creative Cloud. Some updates provide bug fixes 
and security patches, while others supply amazing new features and capabilities.

�e lessons in this book are based on Dreamweaver CC (2017 release) and may 
not work properly in any earlier version of the program. To check which version 
is installed on your computer, choose Help > About Dreamweaver in Windows or 
Dreamweaver > About Dreamweaver on the Macintosh. A window will display the 
version number of the application and other pertinent information.

If you have an earlier version of the program installed, you will have to update 
Dreamweaver to the latest version. You can check the status of your installation by 
opening the Creative Cloud manager and logging in to your account.

Windows macOS

Check out https://helpx.adobe.com/creative-cloud/help/download-install-trial.
html to learn how to download and install a limited-period trial of Creative Cloud 
to your computer or laptop.

https://helpx.adobe.com/creative-cloud/help/download-install-trial.html
https://helpx.adobe.com/creative-cloud/help/download-install-trial.html


6 GETTING STARTED

Online Content 
Your purchase of this Classroom in a Book includes online materials provided by 
way of your Account page on peachpit.com. 

Lesson Files

To work through the projects in this book, you will need to download the lesson 
files from peachpit.com. You can download the files for individual lessons or it may 
be possible to download them all in a single file. 

Web Edition

�e Web Edition is an online interactive version of the book providing an enhanced 
learning experience. Your Web Edition can be accessed from any device with a 
connection to the Internet; it contains the following: 

• �e complete text of the book

• Hours of instructional video keyed to the text

• Interactive quizzes

In addition, the Web Edition may be updated when Adobe adds significant feature 
updates between major Creative Cloud releases. To accommodate the changes, 
sections of the online book may be updated or new sections may be added. 

Accessing the Lesson Files and Web Edition

If you purchased an ebook from peachpit.com or adobepress.com, your Web 
Edition will automatically appear under the Digital Purchases tab on your Account 
page. Click the Launch link to access the product. Continue reading to learn how 
to register your product to get access to the lesson files.

If you purchased an ebook from a different vendor or you bought a print book, 
you must register your purchase on peachpit.com to access the online content:

1 Go to www.peachpit.com/register.

2 Sign in or create a new account.

3 Enter the ISBN 9780134664286.

4 Answer the questions as proof of purchase.

5 �e Web Edition will appear on the Digital Purchases tab on your Account 
page. Click the Launch link to access the product.

�e Lesson Files can be accessed through the Registered Products tab on your 
Account page. Click the Access Bonus Content link below the title of your prod-
uct to proceed to the download page. Click the lesson file links to download 
them to your computer.

� Warning: Do not 
copy the contents of 
one lesson folder into 
any other lesson folder. 
The files and folders for 
each lesson cannot be 
used interchangeably.

http://www.peachpit.com/register
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�e files are compressed into ZIP archives to speed up download time and to 
protect the contents from damage during transfer. You must uncompress (or 
“unzip”) the files to restore them to their original size and format before you use 
them with the book. Modern Mac and Windows systems are set up to open ZIP 
archives by simply double-clicking.

6 Do one of the following:

• If you downloaded DWCC2017_lesson_files.zip, unzipping the archive will 
produce a folder named DWCC2017_Lesson_Files containing all the lesson 
files used by the book.

• If you downloaded the lessons individually, create a new folder on your 
hard drive and name it DWCC2017. Unzip the individual lesson files to this 
folder. �at way, all the lesson files will be stored in one location. Do not 
share or copy files between lessons.

Recommended lesson order
�e training in this book is designed to take you from A to Z in basic to interme-
diate website design, development, and production. Each new lesson builds on 
previous exercises, using supplied files and assets to create an entire website. I 
recommend you download all lesson files at once, and then perform each lesson in 
sequential order to achieve a successful result and the most complete understand-
ing of all aspects of web design.

�e ideal training scenario will start in Lesson 1 and proceed through the entire 
book to Lesson 15. Each lesson builds the skills and understanding necessary to 
complete subsequent tasks. We recommend that you do not skip any lessons, or 

� Note: The files are 
updated from time to 
time, so the date may 
be different than the 
one shown.
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even individual exercises. Although ideal, this method may not be a practicable 
scenario for every user. So, each lesson folder contains all the files needed to com-
plete every exercise within it using partially completed or staged assets, allowing 
you to complete individual lessons out of order, if desired.

However, don’t assume that the staged files and customized templates in each 
lesson represent a complete set of assets. It may seem that these folders contain 
duplicative materials. But these “duplicate” files and assets, in most cases, cannot 
be used interchangeably in other lessons or exercises. Doing so will probably cause 
you to fail to achieve the goal of the exercise.

For that reason, you should treat each folder as a stand-alone website. Copy the 
lesson folder to your hard drive, and create a new site for that lesson using the Site 
Setup dialog. Do not define sites using subfolders of existing sites. Keep your sites 
and assets in their original folders to avoid conflicts.

One suggestion is to organize the lesson folders in a single web or sites master 
folder near the root of your hard drive. But avoid using the Dreamweaver appli-
cation folder. In most cases, you’ll want to use a local web server as your testing 
server, which is described in Lesson 13, “Publishing to the Web.”

Bonus material
We’ve provided additional material for Lessons 2 and 3 and a bonus Lesson 15 on 
the Peachpit website:

• Lesson 2, “HTML Basics Bonus”

• Lesson 3, “CSS Basics Bonus”

• Lesson 15, “Working with Web Animation and Video Bonus” 

You will find these on your Account page once you register your book, as described 
earlier in “Accessing the Lesson Files and Web Edition.”

On first launch
Right after installation or upon first launch, Dreamweaver CC will display several 
introduction screens. �e program will first ask you if you are a new or experienced 
user of Dreamweaver.
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As each screen appears, it guides you through the setup of the interface. Depending 
whether you using Windows or macOS, or select new or experienced user, several 
screens will show different options. You will choose your workspace and color 
theme. I used the lightest theme for the screen shots and the Standard workspace. 
Feel free to pick the theme color you prefer. All exercises in the book will work in 
any color theme.

New User Experienced User
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As you work through the introductory screens, they may appear in a different 
sequence than shown here.  

New User Experienced User

For experienced users, the Introduction screen will preview some of the new fea-
tures added to the program. Review the new features or proceed to the final screen. 

When you complete the setup, the final screen prompts you to get started. Depend-
ing on whether you are a new or experienced user, you may be directed to open a 
file; select a folder or proceed to the program interface.
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New User Experienced User

Once you complete the introductory screens, Dreamweaver may prompt you to Sync 
Settings to the Creative Cloud. �is feature allows you to back up and synchronize 
program preferences between two machines using your account. Click Advanced to 
access the Sync Settings in Preference. Click Disable Sync Settings to shut off synchro-
nization. Click Sync Setting Now to synchronize your settings immediately.

Choosing the program color theme 
If you purchased the book after you installed and launched Dreamweaver, you may be 
currently using a different color theme than the one pictured in most screen shots in 
the book. All exercises will function properly using any color theme, but if you want 
to configure your interface to match the one shown, complete the following steps.

1 Select Edit > Preferences in Windows or Dreamweaver CC > Preferences in macOS. 

�e Preferences dialog appears.

2 Select the Interface category.

3 Select the lightest color theme.
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�e interface changes to the new theme. Note how the Code theme changed 
too. But the changes are not permanent. If you close the dialog, the theme will 
revert to the original colors.

4 Click the Apply button.

�e theme changes are now permanent. 

5 Click the Close button. 

Feel free to change the color theme at any time. Often users select the theme that 
works best in their normal working environment. �e lighter themes work best in 
well-lighted rooms, while the darker themes work best in indirect or controlled 
lighting environments used in some design offices. All exercises will work properly 
in any theme color. 

Setting up the workspace
Dreamweaver CC (2017 release) includes two main workspaces to accommodate 
various computer configurations and individual workflows. For this book, the 
Standard workspace is recommended.

1 If the Standard workspace is not displayed by default, you can select it from the 
Workspace drop-down menu on the upper-right side of the screen.

2 If the default Standard workspace has been modified—where certain toolbars 
and panels are not visible (as they appear in the figures in the book)—you can 
restore the factory setting by choosing Reset ‘Standard’ from the Workspace 
drop-down menu.

Workspace Layout options can also be accessed from the Window menu.

Most of the figures in this book show the Standard workspace. When you finish 
the lessons in this book, experiment with each workspace to find the one that you 
prefer, or build your own configuration and save the layout under a custom name.

For a more complete description of the Dreamweaver workspaces, see Lesson 1, 
“Customizing Your Workspace.”
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Defining a Dreamweaver site
In the course of completing the following lessons, you will create webpages from 
scratch and use existing files and resources that are stored on your hard drive. �e 
resulting webpages and assets make up what’s called your local site. When you are 
ready to upload your site to the Internet (see Lesson 13, “Publishing to the Web”), 
you publish your completed files to a web-host server, which then becomes your 
remote site. �e folder structures and files of the local and remote sites are usually 
mirror images of one another.

�e first step is to define your local site.

1 Launch Adobe Dreamweaver CC (2017 release) or later.

2 Open the Site menu.

�e Site menu provides options for creating and managing standard 
 Dreamweaver sites.

3 Choose New Site.

�e Site Setup dialog appears. 

� Warning: You must 
unzip the lesson files 
before you create your 
site definition.
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To create a standard website in Dreamweaver, you need only name it and select 
the local site folder. �e site name should relate to a specific project or client 
and will appear in the Files panel Site drop-down menu. �is name is intended 
for your own purposes only; it will not be seen by the public, so there are no 
limitations to the name you can create. Use a name that clearly describes the 
purpose of the website. For the purposes of this book, use the name of the les-
son you intend to complete, such as lesson01, lesson02, lesson03, and so on.

4 Type lesson01 or another name, as appropriate, in the Site Name field.

5 Next to the Local Site Folder field, click the Browse for Folder icon .

�e Choose Root Folder dialog appears.

6 Navigate to the appropriate folder containing the lesson files you downloaded 
from Peachpit.com (as described earlier) and click Select/Choose.

You could click Save at this time and begin working on your new website, but 
you’ll add one more piece of handy information.

7 Click the arrow next to the Advanced Settings category to reveal the categories 
listed there. Select Local Info.

Although it’s not required, a good policy for site management is to store differ-
ent file types in separate folders. For example, many websites provide indi-
vidual folders for images, PDFs, videos, and so on. Dreamweaver assists in this 
endeavor by including an option for a Default Images folder. 

Later, as you insert images from other locations on your computer, 
 Dreamweaver will use this setting to automatically move the images into the 
site structure.

� Note: The main 
folder that contains the 
site will be referred to 
throughout the book as 
the site root folder.

� Note: Lesson files 
must be decompressed 
prior to defining 
the site.

� Note: The folder 
that contains the image 
assets will be referred to 
throughout the book as 
the site default images 
folder or the default 
images folder.
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8 Next to the Default Images Folder field, click the Browse for Folder icon. When 
the dialog opens, navigate to the appropriate images folder for that lesson or site 
and click Select/Choose.

�e path to the images folder appears in the Default Images Folder field. �e 
next step would be to enter your site domain name in the Web URL field.

9 Enter http://green-start.org for the lessons in this book, or enter your own 
website URL, in the Web URL field.

You’ve entered all the information required to begin your new site. In subse-
quent lessons, you’ll add more information to enable you to upload files to your 
remote and testing servers.

10 In the Site Setup dialog, click Save. 
�e Site Setup dialog closes.

In the Files panel, the new site name appears in the site list drop-down menu. 
As you add more site definitions, you can switch between the sites by selecting 
the appropriate name from this menu.

� Note: Resource fold-
ers for images and other 
assets should always be 
contained within the 
main site root folder.

� Note: The Web URL 
is not needed for most 
static HTML sites, but 
it’s required for work-
ing with sites using 
dynamic applications or 
to connect to databases 
and a testing server.

http://green-start.org
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Whenever a site is selected or modified, Dreamweaver will build, or rebuild, 
a cache of every file in the folder. �e cache identifies relationships between 
the webpages and the assets within sites and will assist you whenever a file is 
moved, renamed, or deleted to update links or other referenced information.

11 Click OK to build the cache, if necessary.

Setting up a site is a crucial first step in beginning any project in Dreamweaver. 
Knowing where the site root folder is located helps Dreamweaver determine link 
pathways and enables many sitewide options, such as orphaned-file checking and 
Find and Replace.

Checking for updates
Adobe periodically provides software updates. To check for updates in the pro-
gram, choose Help > Updates in Dreamweaver. An update notice may also appear 
in the Creative Cloud update desktop manager.

For book updates and bonus material, visit your Account page on Peachpit.com 
and select the Lesson & Update Files tab.
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Additional resources
Adobe Dreamweaver CC Classroom in a Book (2017 release) is not meant to replace 
documentation that comes with the program or to be a comprehensive reference 
for every feature. Only the commands and options used in the lessons are explained 
in this book. For comprehensive information about program features and tutorials, 
refer to these resources:

Adobe Dreamweaver Learn & Support: helpx.adobe.com/dreamweaver 
(accessible in Dreamweaver by choosing Help > Help And Support > Dreamweaver 
Support Center) is where you can find and browse tutorials, help, and support on 
Adobe.com.

Dreamweaver Help: helpx.adobe.com/support/dreamweaver.html is a reference 
for application features, commands, and tools (press F1 or choose Help > Help And 
Support > Dreamweaver Online Help). You can also download Help as a PDF docu-
ment optimized for printing at helpx.adobe.com/pdf/dreamweaver_reference.pdf.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions and 
questions and answers on Adobe products.

Resources for educators: www.adobe.com/education and edex.adobe.com offer a 
treasure trove of information for instructors who teach classes on Adobe software. 
You’ll find solutions for education at all levels, including free curricula that use an 
integrated approach to teaching Adobe software and that can be used to prepare 
for the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Add-ons: creative.adobe.com/addons is a central resource for finding 
tools, services, extensions, code samples, and more to supplement and extend your 
Adobe products.

Adobe Dreamweaver CC product home page: www.adobe.com/products/ 
dreamweaver has more information about the product.

Adobe Authorized Training Centers
Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products. A directory of AATCs is available at training.adobe.com/
trainingpartners.

http://www.adobe.com/education
http://www.adobe.com/products/dreamweaver
http://www.adobe.com/products/dreamweaver
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WEB DESIGN BASICS

Lesson overview
In this lesson, you’ll learn the following:

• �e basics of webpage design

• How to create page thumbnails and wireframes

• How to use Adobe Photoshop to generate site image assets 
automatically

�is lesson will take about 30 minutes to complete. If you have not 
already done so, download the project files for this lesson from the 
Lesson & Update Files tab on your Account page at www.peachpit.com, 
store them on your computer in a convenient location, and define a new 
site in Dreamweaver based on this folder, as described in the “Getting 
Started” section at the beginning of this book. Your Account page is also 
where you’ll find any updates to the chapters or to the lesson files. Look 
on the Lesson & Update Files tab to access the most current content.

4

http://www.peachpit.com


93

Whether you use thumbnails and wireframes, 
Photoshop, or just a vivid imagination, Dreamweaver 
can quickly turn your design concepts into complete, 
standards-based CSS layouts.
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Developing a new website
Before you begin any web design project for yourself or for a client, you need to 
answer three important questions:

• What is the purpose of the website?

• Who is the audience?

• How do they get here?

What is the purpose of the website?
Will the website sell or support a product or service? Is your site for entertainment 
or games? Will you provide information or news? Will you need a shopping cart 
or database? Do you need to accept credit card payments or electronic transfers? 
Knowing the purpose of the website tells you what type of content you’ll be devel-
oping and working with and what types of technologies you’ll need to incorporate.

Who is the audience?
Is the audience adults, children, seniors, professionals, hobbyists, men, women, 
everyone? Knowing who your audience will be is vital to the overall design and 
functionality of your site. A site intended for children probably needs more ani-
mation, interactivity, and bright, engaging colors. Adults will want serious con-
tent and in-depth analysis. Seniors may need larger type and other accessibility 
enhancements.

A good first step is to check out the competition. Is there an existing website 
performing the same service or selling the same product? Are they successful? 
You don’t have to mimic others just because they’re doing the same thing. Look 
at Google and Yahoo—they perform the same basic service, but their site designs 
couldn’t be more different from one another.

How do they get here?
�is sounds like an odd question when speaking of the Internet. But just as with  
a brick-and-mortar business, your online customers can come to you in a variety 
of ways. For example, are they accessing your site on a desktop computer, lap-
top, tablet, or cellphone? Are they using high-speed Internet, wireless, or dial-up 
service? What browser are they most likely to use, and what is the size and resolu-
tion of the display? �ese answers will tell you a lot about what kind of experience 
your customers will expect. Dial-up and cellphone users may not want to see a lot 
of graphics or video, whereas users with large flat-panel displays and high-speed 
connections may demand as much bang and sizzle as you can send at them.
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So where do you get this information? Some you’ll have to get through painstaking 
research and demographic analysis. Some you’ll get from educated guesses based 
on your own tastes and understanding of your market. But a lot of it is actually 
available on the Internet itself. W3Schools, for one, keeps track of tons of statistics 
regarding access and usage, all updated regularly:

• http://w3schools.com/browsers/default.asp provides information about browser 
statistics.

• http://w3schools.com/browsers/browsers_os.asp gives the breakdown on oper-
ating systems. In 2011, W3Schools started to track the usage of mobile devices 
on the Internet.

• http://w3schools.com/browsers/browsers_display.asp lets you find out the latest 
information on the resolution, or size, of screens using the Internet.

If you are redesigning an existing site, your web-hosting service itself may provide 
valuable statistics on historical traffic patterns and even the visitors themselves. 
If you host your own site, you can incorporate third-party tools, such as Google 
Analytics and Adobe Omniture, into your code to do the tracking for you for free 
or for a small fee.

As of the fall of 2016, Windows still dominates the Internet (80 to 85 percent), with 
most users favoring Google Chrome (73 percent), followed by Firefox (16 percent), 
with various versions of Internet Explorer (5 percent) a distant third. �e vast 
majority of browsers (99 percent) are set to a resolution higher than 1024 pixels by 
768 pixels. If it weren’t for the rapid growth in usage of tablets and smartphones for 
accessing the Internet, these statistics would be great news for most web designers 
and developers. But designing a website that can look good and work effectively for 
both flat-panel displays and cellphones is a tall order.

Analytics provides com-
prehensive statistics on 
the visitors to your site. 
Google Analytics, pic-
tured here, is a popular 
choice.

http://w3schools.com/browsers/default.asp
http://w3schools.com/browsers/browsers_os.asp
http://w3schools.com/browsers/browsers_display.asp
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Responsive web design
Each day, more people are using cellphones and other mobile devices to access the Internet. Some 
people may use them to access the Internet more frequently than they use desktop computers. This 
presents a few nagging challenges to web designers. For one thing, cellphone screens are a fraction of 
the size of even the smallest flat-panel display. How do you cram a two- or three-column page design 
into a meager 300 to 400 pixels? Another problem is that mobile device manufacturers have dropped 
support for Flash-based content on their devices.

Until the last few years, web design usually required that you target an optimum size (height and width in 
pixels) for a webpage and then build the entire site on these specifications. Today, that scenario is becom-
ing a rare occurrence. Now, you are presented with the decision to build a site that either can scale to any 
size display (responsive) or can morph to support a few target display types for desktop and mobile users 
(adaptive).

Your own decision will be based in part on the content you want to provide and on the capabilities of 
the devices accessing your pages. Building an attractive website that supports video, audio, and other 
dynamic content is hard enough without throwing in a panoply of different display sizes and device capa-
bilities. The term responsive web design was coined, in a book of the same name (2011), by a Boston-based 
web developer named Ethan Marcotte. In it he describes the notion of designing pages that can adapt 
to multiple screen dimensions automatically. As you work through the following lessons, you will learn 
many techniques for responsive web design and implement them in your site and asset design.

Many of the concepts of print design are not applicable to the web, because you are not in control of the 
user’s experience. For example, print designers know in advance the page size for which they are design-
ing. The printed page doesn’t change when you rotate it from portrait to landscape. On the other hand,  
a page carefully designed for a typical flat panel is basically useless on a cellphone.
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Scenario
For the purposes of this book, you’ll be working to develop a website for Meridien 
GreenStart, a fictitious community-based organization dedicated to green invest-
ment and action. �is website will offer a variety of products and services and 
require a broad range of webpage types, including dynamic pages using technolo-
gies such as jQuery, which is a form of JavaScript.

Your customers come from a wide demographic that includes all ages and educa-
tional levels. �ey are people who are concerned about environmental conditions 
and who are dedicated to conservation, recycling, and the reuse of natural and 
human resources.

Your marketing research indicates that most of your customers use desktop com-
puters or laptops, connecting via high-speed Internet services. You can expect to 
get 20 to 30 percent of your visitors exclusively via cellphone and other mobile 
devices, and much of the rest will be using mobile from time to time.

To simplify the process of learning Dreamweaver, we’ll focus on creating a fixed-
width desktop site design first. In Lesson 7, “Designing for Mobile Devices,” you’ll 
learn how to adapt your fixed-width design to work with smartphones and tablets.

Working with thumbnails and wireframes
After you have nailed down the answers to the three questions about your website 
purpose, customer demographic, and access model, the next step is to determine 
how many pages you’ll need, what they will do, and what they will look like.

Creating thumbnails
Many web designers start by drawing thumbnails with pencil and paper. �ink of 
thumbnails as a graphical shopping list of the pages you’ll need to create for the 
website. �umbnails can help you work out the basic navigation structure for the 
site. Draw lines between the thumbnails showing how navigation will connect them.

Thumbnails list the 
pages that need to  
be built and how  
they are connected  
to each other.
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Most sites are divided into levels. Typically, the first level includes all the pages in 
your main navigation menu—the ones a visitor can reach directly from the home 
page. �e second level includes pages you can reach only through specific actions 
or from specific locations, say from a shopping cart or product detail page.

Creating a page design
Once you’ve figured out what your site needs in terms of pages, products, and 
services, you can then turn to what those pages will look like. Make a list of compo-
nents you want or need on each page, such as headers and footers, navigation, and 
areas for the main content and the sidebars (if any). Put aside any items that won’t 
be needed on every page. What other factors do you need to consider? If mobile 
devices are going to be an important consideration of your design identity, will any 
of the components be required or optional for these devices? Although many com-
ponents can be simply resized for mobile screens, some will have to be completely 
redesigned or reimagined.

Do you have a company logo, business identity, graphic imagery, or color scheme 
you want to match or complement? Do you have publications, brochures, or cur-
rent advertising campaigns you want to emulate? It helps to gather them all in one 
place so you can see everything all at once on a desk or conference table. If you’re 
lucky, a theme will rise organically from this collection.

Desktop or mobile

Once you’ve created your checklist of the components that you’ll need on each 
page, sketch out several rough layouts that work for these components. Depend-
ing on your target visitor demographics, you may decide to focus on a design 
that’s optimized for desktop computers or one that works best on tablets and 
smartphones.

Most designers settle on one basic page design that is a compromise between 
flexibility and sizzle. Some site designs may naturally lean toward using more than 
one basic layout. But resist the urge to design each page separately. Minimizing the 
number of page designs may sound like a major limitation, but it’s key to produc-
ing a professional-looking site that’s easy to manage. It’s the reason why some 
professionals, such as doctors and airline pilots, wear uniforms. Using a consistent 
page design, or template, conveys a sense of professionalism and confidence to 

Identifying the essential 
components for each 
page helps you create 
a page design and 
structure that will meet 
your needs.
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your visitor. While you’re figuring out what your pages will look like, you’ll have to 
address the size and placement of the basic components. Where you put a compo-
nent can drastically affect its impact and usefulness.

In print, designers know that the upper-left corner of a layout is considered one 
of the “power positions,” a place where you want to locate important aspects of 
a design, such as a logo or title. �is is because in western culture we read from 
left to right, top to bottom. �e second power position is the lower-right corner, 
because this is the last thing your eyes will see when you’re finished reading.

Unfortunately, in web design this theory doesn’t hold up for one simple reason: You 
can never be certain how the user is seeing your design. Are they on a 20-inch flat 
panel or a 3-inch wide smartphone?

In most instances, the only thing you can be certain of is that the user can see the 
upper-left corner of any page. Do you want to waste this position by slapping the 
company logo here? Or make the site more useful by slipping in a navigational 
menu? �is is one of the key predicaments of the web designer. Do you go for 
design sizzle, workable utility, or something in between?

Creating wireframes
After you pick the winning design, wireframing is a fast way to work out the 
structure of each page in the site. A wireframe is like a thumbnail, but bigger, that 
sketches out each page and fills in more details about the components, such as 
actual link names and main headings, but with minimal design or styling. �is step 
helps to anticipate problems before you smack into them when working in code.

Once the basic concepts are worked out, many designers take an extra step and 
create a full-size mock-up or “proof of concept” using a program like Photoshop or 
even Adobe Illustrator. It’s a handy thing to do because you’ll find that some clients 
just aren’t comfortable giving an approval based only on pencil sketches. �e 
advantage here is that all these programs allow you to export the results to full-size 
images (JPEG, GIF, or PNG) that can be viewed in a browser as if they were fin-
ished webpages. Such mock-ups are as good as seeing the real thing but may take 
only a fraction of the time to produce. 

Wireframes allow you to 
experiment with page 
designs quickly and 
easily without wasting 
time with code.
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To demonstrate how a graphics program could be used to build such a mock-up, 
I created a sample webpage layout using Photoshop and saved it into the Lesson 4 
resources folder. Let’s take a look.

1 Launch Photoshop CC or higher.

2 Open GreenStart_mockup.psd from the lesson04/resources folder.

�e Photoshop file contains a complete mock-up of the GreenStart site design, 
which is composed of various vector-based design components as well as image 
assets stored in separate layers. Note the use of colors and gradients in the design.

In addition to creating graphical mock-ups, Photoshop has tricks geared specifi-
cally for web designers. So you can see these features firsthand, I’ve provided a 
bonus online lesson where you can learn how to use Photoshop to create your web 
image assets from this file. Check out the “Getting Started” section at the beginning 
of the book to learn how to access the bonus lesson.

The wireframe for the 
final design should 
identify all components 
and include specific 
information about 
content, color, and 
dimensions.

� Note: You should 
be able to open this 
file with any version 
of  Photoshop CC or 
higher. Be aware if you 
use a version different 
from the one pictured, 
the panels and menu 
options may appear 
different.

� Note: The mock-up 
uses fonts from Typekit, 
Adobe’s online font 
service. To view the 
final design properly 
in Photoshop, you will 
need to download and 
install these fonts. Type-
kit fonts are included 
in your subscription to 
Creative Cloud.
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Review questions
1 What three questions should you ask before starting any web design project?

2 What is the purpose of using thumbnails and wireframes?

3 Why is it important to create a design that takes into account smartphones 
and tablets?

4 What is responsive design, and why should Dreamweaver users be aware of it?

5 Why would you use Photoshop, Illustrator, or other programs, like Adobe Fireworks 
to design a website?

Review answers
1 What is the purpose of the website? Who is the audience? How did they get here? 

�ese questions, and their answers, are essential in helping you develop the design, 
content, and strategy of your site.

2 �umbnails and wireframes are quick techniques for roughing out the design and 
structure of your site without having to waste lots of time coding sample pages.

3 Mobile device users are one of the fastest-growing demographics on the web. Many 
visitors will use a mobile device to access your website on a regular basis or exclusively. 
Webpages designed for desktop computers often display poorly on mobile devices, 
making the websites difficult or impossible to use for these mobile visitors.

4 Responsive design is a method for making the most effective use of a webpage, and its 
content, by designing it to adapt to various types of displays and devices automatically. 

5 Using Photoshop, Illustrator, or Fireworks, you can produce page designs and mock-
ups much faster than when designing in code with Dreamweaver. Designs can even 
be exported as web-compatible graphics that can be viewed in a browser to get 
client approval.
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A
<a> element, 57, 145, 344, 375
absolute hyperlinks, 345, 356–358
Accordion widgets. See Bootstrap 

Accordion widgets
Add Behavior icon, 390, 396, 399
Add Class/ID icon, 162, 176, 315, 

316, 364
Add CSS Source icon, 142
Add New Server icon, 419, 423
Add Selector icon, 163, 268, 316
Adobe Add-ons, 17, 390, 391
Adobe Authorized Training Centers, 17
Adobe Creative Cloud, 4
Adobe Dreamweaver. See Dreamweaver
Adobe forums, 17
Adobe Muse, 55
Adobe Photoshop. See Photoshop
All mode, CSS Designer, 46, 84
alpha transparency, 309, 311
animation, bonus chapter on, 8
Apply Comment icon, 451, 452
<article> element, 60, 75, 208
<aside> element, 60, 156, 169, 172, 

204, 205
Assets panel, 243, 253, 313, 333
<audio> tag, 60

B
background color, 146–148, 167, 411
background images

adding to headers, 164–167
gradients as, 148–149, 412–413

INDEX

behaviors, 393–403
adding to hyperlinks, 399–401
applying, 390, 395–398
overview of, 390–391
removing applied, 398–399
responsive design and, 401–403
review questions/answers on, 415
Swap Image behavior, 395–397
Swap Image Restore behavior, 

397–398
Behaviors panel, 390, 395
Berners-Lee, Tim, 54
bit depth, 308
<blockquote> element, 57, 170, 172, 266
<body> element, 57, 443
bonus material, 8
Bootstrap, 113–125

adding semantic elements to, 
122–125

code inconsistency cleanup, 138–139
column width manipulation, 

210–215
component width management, 

178–180
creating layouts with, 116–122
Customize options, 115
hiding unwanted content using, 

203–206
mobile device design and, 200–215
read-only style sheet, 143

Bootstrap Accordion widgets, 404–414
inserting into layouts, 404–407
styling, 407–414



ADOBE DREAMWEAVER CC CLASSROOM IN A BOOK (2017 RELEASE)  479

manually writing, 442–444
multicursor support for, 449–450
review questions/answers on, 474–475
selection options for, 468–470
Split view option for, 472
See also CSS; HTML

Code Hinting window, 268, 443–444
Code Navigator, 79–83
Code view, 26

CSS styling in, 46
Find and Replace feature, 299–300
hyperlink tools used in, 381
long selectors created in, 292
previewing assets in, 472–473
Refresh button, 407
selecting code in, 468–470
Split view option, 472
writing code in, 442–449

collapsing/expanding code, 470–471
color

background, 146–148, 167, 411
text, 158–159

color picker, 148, 159
color space, 308–309
color themes, 11–12
column widths, 210–215
comma-separated values (CSV) file, 283
comments, 57, 451–452
Commit icon, 323, 330, 337
Common toolbar, 26, 451
Compare option, 436
compiling CSS code, 458–460
compression, image file, 310–311
COMPUTED option, 46, 85–86
Connect to Remote Server icon, 431
Container-fluid option, 118
content placeholders, 174–175
copying/pasting

code to find/replace, 300–301
consistent view required for, 383, 394
CSS properties, 221–224
images from Photoshop, 327–331
styles, 285–286, 410
tables, 276–277

Crop tool, 337–338, 339

borders
accordion, 411
indented text, 269
navigation menu, 149–151
table row, 279

box model, 72–73
<br> tag, 57, 255
Brightness and Contrast tool, 339
Browse for File icon, 350, 381, 387
Browse for Folder icon, 14, 15, 454, 455
browsers. See web browsers

C
<canvas> tag, 60
captions, table, 287–288
cascade theory, 74, 76
CC Files option, 22
cells, styling table, 278–281
character entities, 58–59
Check Spelling dialog, 295–296
child pages, 235–246

adding content to, 237–241
creating new, 236–237
formatting content in, 241–243
hyperlink updates in, 354–355
updating, 243–246, 354–355

<cite> element, 172, 261
class attributes, 87–88
classes

creating custom, 161–163, 176–178
pseudo-classes and, 145

Classroom in a Book series, 1
clipboard, 255
cloaking process, 426–427
code, 440–475

automatically writing, 445–449
collapsing/expanding, 470–471
comments added to, 451–452
Common toolbar for, 451
creating HTML, 442–449
CSS preprocessors for, 452–466
Emmet toolkit for, 445–449
font in book indicating, 2
Linting support for, 467–468
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Current mode, CSS Designer, 46, 47, 84, 415
custom classes, 161–163, 176–178
custom media queries, 217–218, 316
Customize Toolbar dialog, 451

D
declarations, 73
Delete icon, 223, 436
dependent files, 431
deprecated tags, 67
descendant theory, 77
Design view, 27, 255, 273, 282, 324
designing webpages. See web design
destination links

adding to the same page, 386
Element HUD for creating, 366–367
id attribute for creating, 365–366

Developer workspace, 31, 442
Disable icon, 223
dithering process, 308
<div> element, 57, 106, 122, 127
Document toolbar, 25
DOM Viewer, 48, 170–174, 207–208
dpi (dots per inch), 307
dragging and dropping images, 333–335
Dreamweaver

color themes, 11–12
graphic tools, 339
installing, 4
introduction screens, 8–11
resources, 17
site setup, 13–16
updating, 5, 16
workspaces, 12

drop shadows, 160–161
drop zone, 35
drop-down menus, 370–385

adding hyperlinks to, 381–382
creating, 370–373
identifying styling on, 377–381
moving to site template, 382–385
styling, 374–377
See also navigation menus

.dwt file extension, 231
dynamic templates, 231

cropping images, 337–338
CSS (cascading style sheets), 64–91

bonus lesson on, 66, 68
box model, 72–73
cascade theory, 74, 76
class and id attributes, 87–89
code compilation, 458–460
Code Navigator tool, 79–83
copying/pasting properties, 221–224
CSS Designer tool, 43–47, 83–86
current version, 89–90
descendant theory, 77
HTML comparison, 66–68
inheritance theory, 76
multiple element formatting, 86
positioning images using, 314–317
preprocessors, 452–466
pseudo-classes, 145
rules and rule syntax, 73–74, 75, 219–220
selector nesting, 461–463
shorthand techniques, 87
specificity theory, 77–78
style sheet imports, 465–466
styling tables with, 277–278
support resources, 90
values calculation, 463–464

CSS3, 89–90
CSS Designer, 43–47, 83–86

All and Current modes, 46–47, 84
copying/pasting properties, 221–222
example of working with, 139–145
@Media window, 44
Properties window, 45–46, 85
Selectors window, 44, 85
Sources window, 43
style sheet creation, 142–145

CSS preprocessors, 452–466
code compilation, 458–460
enabling, 453–455
resources on, 454, 466
selector nesting, 461–463
source file creation, 455–458
style sheet imports, 465–466
values calculation, 463–464

CSS Property inspector, 40
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FTP sites
connection options, 421
steps for setting up, 419–423
troubleshooting connections to, 422

G
Get icon, 433, 434, 436
GIF file format, 310
Google Analytics, 95
Google Maps, 356–358
gradient backgrounds, 148–149, 412–413
graphic tools in Dreamweaver, 339
graphics

raster, 306–311
vector, 306
See also images

H
<h1> to <h6> tags, 57, 258
<head> tag, 57, 231
<header> element, 60, 156, 158, 164, 167, 169
headers, 156–169

background images for, 164–167
color backgrounds for, 167
custom classes for, 161–163
design effects for, 167–169
entering text for, 156–157
formatting text for, 158–161

headings, creating, 258–259
heads-up displays (HUDs), 48–49

Element HUD, 48–49, 358, 360–361, 366–367
Image HUD, 49, 322
Position Assist HUD, 48, 405
Text HUD, 49, 357, 361–362, 368

Help reference, 17
hexadecimal colors, 167
<hgroup> tag, 60
hiding elements, 203–206
high color, 309
hinting menu, 154, 160, 204, 269
home page

hyperlinks to, 352–354
setting up, 428–429

<hr> tag, 57

E
Edge Web Fonts, 183–188
Edit HTML Attributes icon, 314, 334, 360, 364
Edit Image Settings tool, 339
Edit image tool, 339
editable regions

formatting content in, 241–243
inserting into templates, 231–233

Element HUD, 48–49, 358, 360–361, 366–367
element references, 3
<em> tag, 57, 357
email links, 347, 358–362

creating, 359–360
image-based, 360–361
text-based, 361–362
warning about, 362

embedded formatting, 73
Emmet toolkit, 445–449
external hyperlinks, 344, 356–358
Extract workflow, 36–37

F
<figcaption> tag, 60
<figure> tag, 60, 241
File Activity icon, 432
file formats

for raster images, 310–311
for vector graphics, 306

Files panel, 419, 427, 431, 432, 434, 435
Find and Replace feature, 297–301
fonts

Edge Web, 183–188
size specifications for, 160, 191–193
stacks of, 184, 189–191
typefaces vs., 183
Typekit, 100, 185
web-hosted, 185, 189

<footer> tag, 60
<form> tag, 57
freezing

JavaScript, 377, 378
navigation menus, 368–369

FTP (File Transfer Protocol), 418
FTP over SSL/TLS connections, 418
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I
id attributes

creating, 88–89, 444
targeted links and, 362, 365–366, 367–368

<iframe> tag, 57
Ignore option, 436
Image HUD, 49, 322
Image Optimization dialog, 321, 329, 339
Image Property inspector, 40
image-based links, 360–361
images, 304–341

color spaces used for, 308–309
copying/pasting from Photoshop, 327–331
cropping with Crop tool, 337–338
dragging and dropping, 333–335
file formats for, 306, 310–311
inserting on a webpage, 312–314, 318–324
making responsive, 334–335
non-web file type, 321–324
optimizing with Property inspector, 335–338
Photoshop Smart Objects as, 325–327
positioning, 314–317
Quality setting for, 321
raster graphics, 306–311, 330
resolution of, 307–308, 324
screen size and, 331–333
size of, 308, 324, 337
tools for editing, 339
vector graphics, 306

Images category icon, 313, 333
<img> element, 57, 314
.img-responsive class, 335
Import Tabular Data dialog, 284
importing

CSS style sheets, 465–466
text, 253–256

indented text, 266–269
inheritance theory, 76
inline formatting, 73
<input> tag, 57
Insert menu, 320–321
Insert panel, 118, 131, 318–319
Insert Row with Columns dialog, 119, 120–121

HTML (HyperText Markup Language), 52–63
automatically writing, 445–449
bonus exercises on, 56
character entities, 58–59
comments added to, 452
CSS comparison, 66–68
current version, 59–61
defaults, 68–70
Emmet toolkit for, 445–449
historical origins, 54–55
manually writing, 442–444
structure of webpage using, 56
table formatting and, 272
tags, 55, 56–58, 443

HTML5, 59–61
Bootstrap and, 122–125
quote attribution in, 261
semantic web design, 60–61
tags, 59–60

HTML entities, 180–182
HTML Property inspector, 39
HTML structures, 259–262
<html> tag, 57
HUDs. See heads-up displays
Hyperlink icon, 357
hyperlinks, 342–387

absolute, 345, 356–358
adding behaviors to, 399–401
checking on pages, 385–386
destination, 365–368, 386
drop-down menu, 381–382
editing/removing, 349
email, 347, 358–362
external, 344, 356–358
home page, 352–354
image-based, 360–361
internal, 344, 348–356
navigation menu, 151–153
placeholder for, 350, 399, 400
pseudo-classes for, 145
relative, 344, 345, 348–352
targeted, 362–368
text-based, 361–362
updating in child pages, 354–355
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<li> element, 57, 265, 372
line numbers, 468–469
<link> element, 57
Link Checker panel, 385–386
linked CSS formatting, 73
links. See hyperlinks
Linting support, 467–468
lists, 262–271

creating, 262–266
indented text in, 266–269
ordered and unordered, 265–266
responsive, 270–271

Live Source Code mode, 29–30
Live view, 27–28, 109, 123

copying text in, 255, 256
editing menus in, 371–372
previewing pages in, 251, 356

Live View Options icon, 378, 380
local site, 13, 418
Locked icon, 237
Lorem generator, 448
lossy compression, 311

M
macOS vs. Windows instructions, 3
<main> element, 60, 169
Make Image Responsive checkbox, 334
Manage Fonts dialog, 186
Manage Sites dialog, 419, 453
map links, 357–358
Marcotte, Ethan, 96
max-width specification, 47, 333
measurement systems, 160
media queries, 200, 215–220

adding rules to, 219–220
creating custom, 217–218
CSS Designer window for, 44
explanation of, 112
identifying, 215–217
resources on, 226
syntax used in, 200
VMQ interface and, 111–113

media type properties, 199
menus. See drop-down menus; navigation menus
<meta> tag, 57, 234, 235

inserting
Bootstrap Accordion widgets, 404–407
editable regions into templates, 231–233
images on a webpage, 312–314, 318–324
metadata into templates, 233–235
rows or columns into tables, 276
tables from other sources, 283–286

Inspect mode, 30
installing Dreamweaver, 4
interactivity, 388–415

Bootstrap Accordion widgets for, 404–414
Dreamweaver behaviors for, 390–391, 393–403
identifying styling on elements with, 377–381
review questions/answers on, 415

interface overview, 18–51
internal hyperlinks, 344, 348–356

home link creation, 352–354
relative link creation, 348–352
targeted link creation, 363–365
updating in child pages, 354–355

introduction screens, 8–11

J
JavaScript

Dreamweaver behaviors as, 390
freezing/unfreezing, 378, 380
hosted fonts requiring, 191

JPEG file format, 310–311
jQuery framework, 389, 404, 414

K
keyboard shortcuts, 37–39

L
layouts

page, 102–127
predefined, 107–125
template creation from, 230–231
workspace, 30–31

LESS CSS preprocessor, 454
lesson files

downloading and unzipping, 6–7
recommended order for using, 7–8
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hyperlinks in, 151–153
replacing, 382–385
steps for creating, 130–135
styling, 146–153
See also drop-down menus

nesting CSS selectors, 461–463
New Document dialog, 107, 443
New Feature guides, 24–25
“no” symbol, 349, 365

O
<ol> element, 58, 265
online materials, 6–7
onMouseOut attribute, 398
onMouseOver attribute, 397, 398
ordered lists, 265

P
<p> element, 58, 75
page design

desktop vs. mobile, 98–99
evaluating options for, 104–106
list of components for, 98

page layouts, 102–127
Bootstrap framework and, 113–125
evaluating design options for, 104–106
Visual Media Queries interface and, 111–113
working with predefined, 107–125

palettes, color, 308–309
panels, 31–35

closing, 33
docking, 35
dragging, 34
floating, 34
grouping and stacking, 35
minimizing, 32–33

Parent Tag selector, 470
Paste Styles option, 286, 410
Photoshop

copying/pasting images from, 327–331
Smart Objects from, 325–327

metadata
image-related, 314
inserting into templates, 233–235

minification, 75
min-width specification, 47
mobile device design, 196–227

Bootstrap framework and, 200–215
column width manipulation and, 210–215
copying/pasting CSS properties, 221–224
media queries and, 200, 215–220, 226
media type properties and, 199
mobile-first design and, 198, 207–210
responsive design and, 198–200, 270–271
Scrubber tool and, 201–203
steps for completing, 224–225
tables and, 288–295

mobile-first design, 198, 207–210
mobile-optimized sites, 206
mock-ups, 99–100
monochrome, 308
multicursor support, 449–450

N
named anchors, 362, 366
<nav> element, 60
nav pills, 372
navbar-fixed-top class, 369
navbars, 131–132
navigation, 342–387

basics of, 344–345
checking on pages, 385–386
drop-down menus for, 370–385
email links for, 358–362
external hyperlinks for, 356–358
image-based links for, 360–361
internal hyperlinks for, 348–356
targeting page elements, 362–368
text-based links for, 361–362
See also hyperlinks

navigation menus, 130–156
adding new items to, 135–138
centering, 153–155
cleaning up, 138–139
CSS Designer and, 139–145
freezing, 368–369
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R
raster graphics, 306–311

color spaces for, 308–309
file formats for, 310–311
resolution of, 307–308
scaling issues, 330
size of, 308

RDS (Remote Development Services), 418
Recent Files option, 22
Refresh icon, 243, 313, 333
regular expressions, 297
Related Files interface, 40–41, 475
relative hyperlinks, 344, 345, 348–352
remote servers, 419, 430
remote sites, 13, 418–425

connection methods, 418
setting up for FTP, 419–423
synchronizing local and, 434–436
testing servers for, 423–425
troubleshooting connections to, 422

Remove Comment icon, 452
Remove Event icon, 399
Resample tool, 339
Reset icon, 323
resolution, 307–308
resources

on Adobe Dreamweaver, 17
on CSS and CSS preprocessors, 90, 454, 466
on media queries, 226

responsive web design, 96
behaviors and, 401–403
images and, 334–335
lists utilizing, 270–271
mobile devices and, 198–200
tables utilizing, 288–295
See also mobile device design

rollover effects, 152, 390, 401, 402, 411–414
rows, table, 274–276
rules, CSS, 73–74, 75, 219–220

S
Sass CSS preprocessor, 454, 456, 463
Save All command, 38, 148, 246
Save Web Image dialog, 322, 329

<picture> element, 60, 324
pixels, 306–307
placeholders

content, 174–175, 448
hyperlink, 350, 399, 400
webpage, 432

PNG file format, 311
Point to File icon, 352
Position Assist HUD, 48, 405
positioning images, 314–317
predefined layouts, 107–125

Bootstrap framework and, 113–125
steps for working with, 107–110
VMQ interface and, 111–113

Preferences dialog, 11, 24
prelaunch checklist, 430
previewing

pages in Live view, 251
pages in web browsers, 289

Property inspector, 39–40
displaying, 175, 233, 275
docking, 253, 275
graphic tools in, 339
optimizing images with, 335–338
Refresh button, 407

pseudo-classes, 145, 291
publishing to the web, 416–439

cloaking process for, 426–427
home page setup for, 428–429
prelaunch checklist for, 430
putting your site online, 430–434
remote site setup for, 418–423
synchronization process for, 434–436
testing servers for, 423–425

punctuation, code, 3
Put icon, 431, 432, 434, 436

Q
queries. See media queries
Quick Start option, 23
Quick Tag Editor, 123, 161, 162, 257, 261
quotations, 169–174
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stacks, font, 184, 189–191
staging servers, 418, 423
Standard toolbar, 25
Standard workspace, 12, 30–31
Start Screen options, 21–24
starter templates, 23, 108
strikethrough formatting, 2
<strong> tag, 58, 357
<style> tag, 58
styling

Accordion widgets, 407–414
copying/pasting, 285–286, 410
drop-down menus, 374–377
identifying on interactive elements, 377–381
navigational menus, 146–153
tables and cells, 277–281

SVG graphics, 306
Swap Image behavior, 395–397
Swap Image Restore behavior, 397–398
synchronization process, 434–436
Synchronize icon, 435
syntax

CSS rule, 75
media query, 200

T
tabbed panels, 404
Table dialog, 272
Table Property inspector, 40
tables, 271–295

caption elements in, 287–288
cell styling for, 278–281
controlling the display of, 281–283
copying and pasting, 276–277
creating from scratch, 271–276
inserting from other sources, 283–286
making responsive, 288–295
moving between cells in, 273
styling with CSS, 277–278

<table> tag, 58, 275, 287
tag selectors, 42, 132, 469–470
tags

HTML, 55, 56–58
HTML5, 59–60

targeted links, 362–368

saving
custom workspaces, 36
pages as templates, 230

<script> tag, 58
Scrubber tool

mobile device design and, 201–203
resizing document windows with, 110, 113

SCSS documents, 456
<section> element, 60, 241, 256, 285
Select File dialog, 350
Select Image Source dialog, 318, 320, 396
selecting code, 468–470

line numbers for, 468–469
parent tags for, 470
tag selectors for, 469–470

selectors
CSS, 73–74, 75, 77, 461–463
tag, 42, 132, 469–470

Selectors window, 44
semantic content, 169–178

adding to Bootstrap, 122–125
creating for text, 256–258
custom element classes and, 176–178
DOM panel for creating, 170–174
main content placeholders and, 174–175
steps for building, 169–170

semantic web design, 60–61
SFTP (Secure FTP), 418
Sharpen tool, 339
shorthand, CSS, 87
Show All option, 24
Show Set option, 45, 85, 142, 269, 278
Site Definition dialog, 453
Site menu, 13
Site Root button, 329
site root folder, 14, 109
Site Setup dialog, 13, 419, 426
Smart Objects, 325–327, 341
smartphones. See mobile device design
<source> tag, 60
<span> tag, 58, 161
special characters, 180–182
specificity theory, 77–78
spell-checking webpages, 295–297
Split Code view, 472
Split view, 28–29, 265
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type. See text
typefaces

fonts distinguished from, 183
using in web design, 182
See also fonts

Typekit fonts, 100, 185

U
<ul> tag, 58, 266
Undo command, 339
unordered lists, 266
Update from Original tool, 339
Update Pages dialog, 245, 355
Update Template Files dialog, 245, 354, 384
updating

child pages, 243–246, 354–355
Dreamweaver, 5, 16
templates, 243–246, 384

uploading files, 430–434

V
values, 160
vector graphics, 306
views, 26–30

Code view, 26
Design view, 27
Inspect mode, 30
Live Source Code mode, 29–30
Live view, 27–28
Split view, 28–29, 472

Visual Media Query (VMQ) interface, 47, 111–113

W
Web 2.0 functionality, 390
web browsers

hyperlink info in, 346
popularity of specific, 71, 95
previewing pages in, 289

creating internal, 363–365
Element HUD for creating, 366–367
id attribute for, 362, 365–366, 367–368

<td> tag, 58, 278, 280
templates, 228–247

adding content to, 237–241
Bootstrap framework, 113–125
child pages produced from, 235–246
creating from existing layouts, 230–231
detaching pages from, 371
drop-down menu, 370–371
editable regions in, 231–233
formatting content in, 241–243
how they work, 230
metadata added to, 233–235
updating, 243–246, 384

Templates category icon, 243, 253
testing

hyperlinks, 355
site functionality, 424
web designs, 219

testing server, 423–425
text, 253–262

finding and replacing, 297–301
font size specification for, 191–193
formatting for headers, 158–161
global type styles for, 182–193
headings created for, 258–259
HTML structures added to, 259–262
importing from documents, 253–256
indented, 266–269
lists created from, 262–271
semantic structures for, 256–258
spell-checking, 295–297

Text HUD, 49, 357, 361–362, 368
<textarea> element, 58
text-based links, 361–362
<th> tag, 58, 278, 279, 280
thumbnails, 97–98
TinyURLs, 1, 476–477
<title> tag, 58, 231, 234
Toggle Size Constrain icon, 323, 337
toolbars, 25–26
<tr> tag, 58, 299
true color, 309
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Windows vs. macOS instructions, 3–4
wireframes, 99–100
workspaces

customizing, 18–51
interface components, 20
prebuilt, 30–31
saving custom, 36
setting up, 12

writing code
automatically, 445–449
manually, 442–444

WYSIWYG view, 20

web design, 92–101
important questions for, 94
page design and, 98–99
responsive, 96, 198–200
statistics relevant to, 95
testing regimen for, 219
thumbnails for, 97–98
wireframes for, 99–100

Web Edition of book, 6
web fonts

building font stacks with, 189–191
Edge Web Fonts as, 185–188

WebDav system, 418
web-safe color palette, 309
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